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Application Note

Eclipse with GCC

Introduction

As a popular integrated development environment (IDE), Eclipse supports various computer
languages including C/C++ through a wide range of plug-ins, adding to the flexibility of Eclipse

2021.12.13

platform, on which the user is able to conduct software IDE.

This Application Note describes how to use Eclipse plug-ins to debug AT32 series chips.

Applicable products:

Part number

AT32F series
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1 Overview

This Application Note gives a detailed description of how to debug AT32 series chips using Eclipse,
ARM-GCC compiler, GNU-ARM plug-ins, JLink and ATLink.

It mainly covers the following contents:

® Eclipse debug environment preparation
® Eclipse template project

® Eclipse compile configuration

® Eclipse debug configuration

Note: This installation manual is based on WINDOWS 7 x64 system, and projects in
AT32Fxx_Firmware_Library\project\at_start xx\templates\eclipse_gcc are used for illustration.

All the software Kits in this document can be found in AT32_Eclipse_Packet.zip, which is unzipped
to install and run.

AT32_Eclipse_Packet.zip contains the following files:

Figure 1. Files in AT32_Eclipse_Packet.zip

B eclipse-cpp-2019-06-R-win32-x86_64.zip

[i! gcc-arm-none-eabi-8-2019-q3-update-win32-shal.exe

Il onuarmeclipse-build-tools-win32-2.6-201507152002-setup.exe
Il snuarmeclipse-build-tools-win64-2.6-201507152002-setup.exe
B ilg.gnumcueclipse.repository-4.5.1-201901011632.zip

2021.12.13 5 Ver 2.0.0
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Eclipse debug environment preparation

First of all, the following software needs to be installed:

® Eclipse IDE for C/C++ Developers

® GNU ARM Eclipse plug-ins

® GCC ARM compiler

® GNU ARM Eclipse Build Tools (make, rm and others)

The subsequent sections introduce how to install these software.
Eclipse IDE for C/C++ Developers

Download the latest version of Eclipse IDE (for C/C++ developers). There is one version available
in AT32_Eclipse_Packet.zip, that is, eclipse-cpp-2019-06-R-win32-x86_64.zip.

Download link: http://www.eclipse.org/downloads/eclipse-packages/

Figure 2 Eclipse download page

133

Download and unzip the eclipse-cpp-2019-06-R-win32-x86_64.zip. Click “eclipse.exe” to run
Eclipse. Note that users need to install plug-ins before debugging code.

GNU ARM Eclipse plug-ins installation
Download and unzip the latest version of GNU ARM Eclipse plug-ins: ilg.gnumcueclipse.repository-
4.5.1-201901011632.zip.

AT32_Eclipse_Packet.zip contains an available version of ilg.gnumcueclipse.repository-4.5.1-
201901011632.zip.

Download link: https://github.com/gnu-mcu-eclipse/eclipse-plugins/releases

Installation steps:

1. Go to Eclipse Help->Install New Software.

6 Ver 2.0.0
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Figure 2. Click on Install New Software

SCHPSECPPE2019-06-R-win32-X86_64 - Eclipse IDE e —
file Edit Source Refactor Navigate Search Project Run Window [Help)
5 | @ Welcome 12 @ Welcome o rafEes
17:] . (@ Help Contents ™
—_ EC“pse Welcome to the EclipEliEagy
Show Contextual Help
Show Active Keybindings... CurleShiftsL
\ Tips and Tricks...
& Report Bug or Enhancement...
= Cheat Sheets...
ot Ul @ Eciipse User Storage »
% Perform Setup Tasks...
%, Check for Updates
>
g aresiliiripd o [l New SoRwore— 1
pref T Eciipse Marketplace...
@ Arduino Downloads Manager
o © About Eclipse IDE
- Create Edlipse project for C/C++ source Contribute
O Find out what
' open a
M 13 ”
2. Click on “Add...
@ Install = L p—
Available Software

J

:wm with: type or select a site

Select a site or enter the location of a site.

| type Fter et

Name

(@ There s no site selected

¥ Show only the Latest versions of available software | Hide items that are already installed

¥] Group items by category

Show anly software applicable to target environment

What is already installed?

7] Contact all update sites during install to find required software

=l

-
o
lansge..

[ seletai
[ Deselect all

[ caneel

3. Add alocal plug-in, or automatically download and install through an Internet path.

Figure 4. Add Repository

2021.12.13

£ Add Repository

Name: |

Location: http://

Add

@

. Local..

Archive...

Cancel

4. Select a local plug-in directory, and click on “Add”.

Ver 2.0.0
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Figure 5. Select plug-in directory

& Add Repository

et

Name:

Lacaﬁon:lIﬁlg,gnumcueclipse.repositnry-4.5.l-201901011632;1‘ I[ Archive... ]

2021.12.13

® [ Add J [ Cancel ]
5. Tick all plug-ins, and click on “Next”.
Figure 6. Tick plug-ins

Woark with:  fleyD:/un.T/ Z 19-06-Rewin32-x86_64/ik 451+

ter text

Narme Version
 [#] 130 GNU ARM & RISC-V C/C# + Cross Development Tools
7] GNU MCU C/C+ + ADUCM380 Project Template
1215 GNU MCU C/C++ ARM Cross Compiler 264.201901011632
¥ @ GNU MCU C/C+ + CodeRed Debug Perspective 1.12.201901011632

] 5 GNU MCU C/Cs + 11

115.201901011632

416 GNU MCU C/C v+ Freescale Praject Templates 229.201901011632
714 GNU MCU C/C++ Generic Certex-M Project Template 1442019010163
9] 4 GNU MCU C/C+ J-ink Debugging 434.201901011632

[swean |
e

Detsils

7| Hide items that are alreody installed

What is alraady instalied?

¥ Shou only the |stest versions of available software
7 Group items by category

Show only saftware applicable to target emvirnment
7| Gontact all update sites during install to find required software

6.

Installation is completed, and click on “Next”.

Figure 7. Installation completed

@ install [
Install Details 1
Review the items. to be installed. .)"!
Hame Version 7
5 GNU MCU C/C -+ ADUCMS80 Project Template 11.5.201901011652 i grumevecipse templates.ad..
5 GNVU MCU C/C+ + ARM Cross Compiler 264.201901011632 g grumcueclipse mansgedbuil..
5 GNU MCU C/C -+ CodeRed Debug Perspective 11.2201901011652 i grumeveclipse codered feat..
4 GNU MCU C/C++ Documentation (Flacshoider] 1122019010116
@ GNU MCU C/C+ + Freescale Project Templates 2.2.8.201901011632 g grumeueclipse templates.fre.
5 GNU MCU C/C++ Generic Cortex-M Project Template 144201501011 g i
G GNU MCU C/C+ + J-ink Bebugging 434 2 ig debug gbjt
G GNU MCU C/C++ Jumper Virtual i L1L20901011632 is. debug.gbjt
@ GNU MCU /C+ + OpendCD Debugging 43 2 is debug gbjt
5 GNU MCU C/C++ Packs (Experimental) 2220901011832 ia b fets
G GNU MCU C/C+ + %/OCD Debugging 13 is debug gbjt
5 GNU MCU C/C+ + QEMU Debugging 12201901013 ia debug gt
4 GNU MCU C/C++ RISC-V Cross Compiler 8. ilg. edbuil
G GNU MCU €€+ + SiFve RISC-V Project Template 13 s i
5 GNU MCU C/Cr + STM326x Project Templates 65201901011 s
Size: 10520 KB
Cetals
@ <pock [ dear | Cancel

L]
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Figure 8. Accept the license agreement

& i

VERNED BY THE TERMS AND

THE TERMS AND CONDITIONS OF
LICENSE AGREEMENTS OR
NOTICES INDICATED OR REFERENCED BELOW. BY USING

GNU MCU C/C+ s ST

OR NOTICES INDICATED OR REFERENCED BELOW. 1F YOU
DO NOT AGREE TO THE
CONDITIONS OF THIS AGREEMENT AND THE
i

ITIONS

UICABLE LICENSE AGREEMENTS OR NOTICES
INDICATED OR REFERENCED

BELOW, THEN YOU MAY NOT USE THE CONTENT.

<Bock Enish Cancel

7. Go to “Install anyway”.

Figure 9. Install anyway

© Security Warning @ =X

Warning: You are installing software that contains unsigned content. The
' % authenticity or validity of this software cannot be established. Do you want to
continue with the installation?

[lnstall anywayl [ Cancel ] i Details >>

8. Restart Eclipse.

Figure 10. Restart Eclipse
= Software Updates | S

—

. Would you like to restart Eclipse IDE to apply the changes?

Restart Now | ’ No

2.3 ARM GCC compiler tool chains installation

Download the latest compiler tool chain: gcc-arm-none-eabi-8-2019-g3-update-win32-sha2.exe.

AT32_Eclipse_Packet.zip contains an available version of gcc-arm-none-eabi-8-2019-g3-update-
win32-sha2.exe.

Download link: https://launchpad.net/gcc-arm-embedded/+download

Installation steps:

1. Select a language.

2021.12.13 9 Ver 2.0.0
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Figure 11. Installer language

Flease select a language.

[Engish

2. Goto Setup wizard, and click on “Next”.

Figure 12. Setup wizard

(i1 GNU Tools for ARM Embedded Processors 8-2019-g3-update EI_Iéj

Welcome to the GNU Tools for ARM
Embedded Processors
8-2019-q3-update 8 2019 Setup

This wizard will guide you through the installation of GNU
Tools for ARM Embedded Processors 8-2019-g3-update &
2019,

It is recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue.

Next > | I Cancel

3. Click on “Accept” for the license agreement.

Figure 13. Accept license agreement

(i1 GNU Tools for ARM Embedded Processors 8-2019-q3-update @_Iéj

License Agreement
Please review the license terms before installing GNU Tools for ARM Embedded K )
Processors 8-2019-g3-update 8 2019,

Press Page Down to see the rest of the agreement.

'

“ontains code from project GMU Binu
GMU Debugger (https: / A

GMU GEMERAL PUBLIC LICENSE
Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <htip://fsf.ora/>
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not alowed.

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install GMU Tools for ARM Embedded Processors 8-2019-g3-update 8 2019.

tile (ht
fsoftware/

< Back ” 1 Agree ]I Cancel

4. Select the default installation location, and click on “Install”.

10
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Figure 14. Installation progress

(5 GNU Tools for ARM Embedded Processors 8-2019-q3-update L= =0 [iee]

Installing

Please wait while GNU Tools for ARM Embedded Processors 8-2019-q3-update 82019 | 4
is being installed.

Extract: c++config.h... 100%
L ]

Show details

5. In the pop-up installation window, tick “Add path to environment variable” for auto add, or else,
you need to do so by manual operation.

Figure 15. Tick “Add path to environment variable”

(51 GNU Tools for ARM Embedded Processors 8-2019-q3-update |£I_‘_J

Completing the GNU Tools for ARM
Embedded Processors
8-2019-q3-update 8 2019 Setup

GNU Tools for ARM Embedded Processors 8-2019-g3-update
8 2019 has been installed on your computer,

Click Finish to dose this wizard,

V| Show Readme

¥|Launch gcovar.bat

V| Add path to environment variable
V| Add registry information

6. After the installation is completed, enter “arm-none-eabi-gcc —v” in the pop-up command
window, and some information including version code will be displayed, indicating that it is a
successful installation.

Figure 16. Installation result displayed

:\Program Files (x86)>\GNU Tools ARM Embedded8 2819-¢3-update>arm—none—eabhi-gcc|j
—u
sing built-in specs
OLLECT _GCC=arm—none— i-gcc

s/prograns FilesN (x86)/gnus toolss arns embedded/ 8% 2019

n/../lih/gcc/arm—none—eahi/8 .3 .1/1to—wrapper.exe

arget: arm—none-eabi
onf igured with: stmp/; ns/jenkins—GCl build_toolchain_docker-594_201987084
562200936 /src/gecc/configure ——hbuild=x86_64-linux—gn host=i686-w64-mingu32 —|
arget=arm—none—eahi ——prefi. -GCC—8-build_toolchain_docker—|
F94_20190764_1562200936/install-mingw mp/jenkins/jenki
ild_toolchain_docker-594_20198784_1562200936/i

1kins/jenkins—GCC—8-huild_toolchain_dx <er—594_20190784_1562288936/install-mingu)
share/doc/gec—arn—none—eabisinfo ——mandir=/tnp/jenk enki 8-build_tool
docker-594_28190784_1562280936/install-mingw 4 >c—arm—none—eahi/m|
htmldi - J ins/jenkins—GCC-8-huild
re/doc/gcc—arn—no

2021.12.13 11 Ver 2.0.0
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2.4  GNU ARM Eclipse Build Tools installation

This section provides information about the setup of such commands as “make” and “rm”.

Download link: https://sourceforge.net/projects/gnuarmeclipse/files/Build Tools/

AT32_Eclipse_Packet.zip contains an available version of gnuarmeclipse-build-tools-win64-2.6-
201507152002-setup.exe, or you may download other applicable versions.

1. Run the installation package.

Figure 17. Run installation package
[l GNU ARM Eclipse Build Tools Setup [ESHESE ")

Welcome to the GNU ARM Eclipse
Build Tools Setup Wizard

This wizard wil guide you through the installation of GNU
ARM Ediipse Build Tools.

Itis recommended that you dose all other applications
before starting Setup. This will make it possble to update
relevant system files without having ta reboot your
computer,

Click Next to continue,

2. Select destination folder.

Figure 18. Select destination folder

frza - P
[l GNU ARM Eclipse Build Tools Setup
Choose Install Location
Choose the folder in which to install GNU ARM Edipse Buiid Tools. a

Setup will install GNU ARM Eclipse Build Tools in the following folder. To install in a different
folder, dick Browse and select another folder. Click Install to start the installation.

Destination Folder

Browse...

Space required: 3.7MB
Space available: 31.7GB

<Back | mstal | [ cancel

3. Restart Eclipse after finishing installation.

Figure 19. Installation completed

GNU ARM Eclipse Build Tools Setup = ——

Completing the GNU ARM Eclipse
Build Tools Setup Wizard

GNU ARM Ediipse Build Tools has been installed on your
computer,

Click Finish to dose this wizard.

Visit the GNU ARM Edlipse site!

2021.12.13 12 Ver 2.0.0
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2.5 Install JLink

It is necessary to copy AT32 series chips to JLink directory through ICP.
1. JLink installation (omitted)
Download and install the latest version of JLink.
2. Copy algorithm file
To recognize and download program to AT32 series chips through JLink, the AT32 algorithm file

should be downloaded to JLink directory through ICP tool (run ICP directly, and the corresponding
AT32 algorithm will be copied to JLink directory).

2021.12.13 13 Ver 2.0.0
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3 Template project configuration and compiling

This section demonstrates how to use template projects.

Project path: AT32Fxx_Firmware_Library\project\at_start_xx\templates\eclipse_gcc.

This section takes AT32F437 as an example to illustrate the project configuration and compilation.

3.1 Open template project

1. Click on File=>Open Projects from File System.

© work_base - Eclipse IDE

New
Open File...
_4 Open Projects from File System...

Recent Files

VEdit Source Refactor Navigate Search Project Run Window Help

Alt+Shift+N »

2. Select a path in “Import source”, and click on “Finish”. AT32F437xx template path:
xxx\AT32F435_ 437 Firmware_Library\project\at_start_f437\templates\eclipse_gcc\template

(similar paths for other series).

type filter text
I Folder
template

Use installed project configurators to:
Search for nested projects
Detect and configure project natures

Warking sets

[T Add project to working sets

@

Import as

Eclipse praject

[Z] Close newly imported projects upon completion

= Back

£ Import Projects from File System or Archive o X ]
Import Projects from File System or Archive s
—__ -
This wizard analyzes the content of your folder or archive file to find projects and import them in the IDE. / /

Import source:  DABSP\AT32F435_437_Firmware_Library\project\at_start_f437\templates\eclipse_gcc\template ~

Select All
Deselect All

[T Hide alreadv open proiects

Select...

Show other specialized import wizards

3. Open the project, and you will see the following template.

2021.12.13
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3.2
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5 wor base - Edip DR

File Edit Source Refactor Mavigate Search Project Run

E 55 Project Explorer &3 <.}=='p Connections = O
l.'_ =) <}=,=l>| by
B templat
B s [ Includes

. & bsp
S|

(= cmsis

s = firmware

¥ [ User

Compile

During the compiling process, the following configurations should be completed.
® Chip configuration

® Header file path configuration

® Macro configuration
o

Script file configuration (Id files of different series)

1. Right click on “Template” and select “Build Project”.

4|55 template! L SEL i i
3;;9 Bi New » |
> [ In Go Into p2
EF' b Open in New Window t'f
& con . . »
& D{ Show in Local Terminal »
@ fin g Copy Crl+C |
* = us Paste Ctri+V ¥
HK Delete Delete :
Remove from Context Ctrl+Alt+Shift+Down
Source » [
Move... o
Rename... F2 E;:
y  Import. .
sy Export. E
Build Project
Clean Project

2. After completion of compiling, the “template.elf’ is generated.

CDT Build Console [template]
Finished building: D:/BSP/AT32F435_437 Firmware_Library/libraries/cmsis/cmd/device_support/system_at32f435_437.c

Building file: D:/BSP/AT32F435_437_Firmware_Library/project/at32f435_437_board/at32f435_437 board.c
Invoking: GNU ARM Cross C Compiler

Finished building: D:fBSP:’AT32F435_43?_Fir|mare_Librar‘y:’pr‘ojec‘tr’at32f435_4§?_boar'd:'a‘t32f435_43?_board,c

Building target: template.elf
Invoking: GNU ARM Cross C Linker

Finished building target: template.elf

15:89:24 Build Finished. @ errors, @ warnings. (teok 11s.383ms)

arm-none-eabi-gcc -mcpu=cortex-mé -mthumb -08 -ffunction-sections -g -DAT_START_F437_V1 -DAT32F437ZIMT7 -DUSE_STDPERIPH_DRIV

arm-none-eabi-gcc -mcpu=cortex-mé -mthumb -08 -ffunction-sections -g -DAT_START_F437_V1 -DAT32F437ZIMT7 -DUSE_STDPERIPH_DRIV

arm-none-eabi-gcc -mcpuscortex-md -mthumb -0@ -ffunction-sections -g -T "D:\BSP\AT32F435_437_Firmware_Library\projectiat_st

15 Ver 2.0.0
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3. For configurations of different models (of the same series), you only need to modify Id files in

Eclipse with GCC

“Settings” as shown below. You can also modify other settings such as header file path in “Settings”
if necessary.

5 Properties for tamplate T R [ 1= A .
type filter text Settings ST Ty

Fle Edit Source Refactor Mavigate Search Project Window Help
& BProjec. B 5 Conne.. T O [g at32f4354 @, Run Ctrl+F11
@ E®le v | 1o/ |8 e u
| 455 template| . X Q- Profile
T T p + g
B > 35, Binaries ; g Profile History »
b I:dUdes E : g Profile As N
g bs| .
_ = P. 7 Profile Configurations...
i = cmsis 3 **H 3
» = Debug 12 - Run History »
b = firmware 11 + 1@ PRunAs 4
P = user 12 *d Run Configurations... i
13 = A
14 T s Debug Histo r
15 *d & v
16 + o| 3% Debug As »
17 . Debug Configurations...
18 * T h
— — - EE—— - . S G S S —— S ——
2021.12.13 16 Ver 2.0.0

> Resource
Builders
a CfC++ Build
Build Variables
Environment
Logging
Settings
Tool Chain Editor
> Cf/C++ General
Linux Tools Path
[ MCU
Project Natures
Project References
Run/Debug Settings
1> Task Repository

Configuration: lDebug [ Active |

- ] [ Manage Configurations...

& Tool Settings | ] Too\chainsl B De'vioesl 0 Container Seﬂingsl 4 Build Slepsl

Buil !

r

g Target Processor

# Optimization

(5 Warnings

( Debugging

4 83 GNU ARM Cross Assembler

@ Preprocessor
(& Includes
& Warnings
(& Miscellaneous

Task Tags A e ‘I
» Validation T o ross C Compiler
WikiText 2 Preprocessor

(& Includes
# Optimization
(& Warnings
(& Miscellaneous

4 8 GNU ARM Cross C Linker
(2 General
(& Libraries
& Miscellaneous

4 3 GNU ARM Cross Create Flash Image
(# General

4 i GNU ARM Cross Print Size
(& General

Script files (-T)

“${workspace_proje

« 1

[7] Do not use standard start files (-nostartfiles)
[7] Do not use default libraries (-nodefaultlibs)

[T Mo startup or default libs (-nostdlib)

Remove unused sections (-Xlinker --gc-section:
[] Print removed sections (-Xlinker --print-gc-sect

[ Omit all symbal information (-s)
< . | v

[Reslore Defaullsl [ Apply

]

|App|y and Closel [ Cancel
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S Debug Configurations

Create, manage, and run configurations

0 e X B3~

type filter text

[€] C/C++ Application
[€] C/C++ Attach to Application
[£] C/C++ Container Launcher
[t] C/C++ Postmortem Debugger
[t] C/C++ Remote Application
Cii C/C++ Unit
[£] GDB Hardware Debugging
[€] GDB Jumper Debugging
4[] GDB OpenOCD Dahitasina |
[E] template § [ New Configuration
[c] GD8 PyocD { ¢

New Prototype

[c] GDB QEMUL (& Export.
[t] GDB SEGGER Duplicate
& Launch Groug % Delete

= Launch Groug
L| Link Prototype...

ul  Unlink Prototype

rl Reset with Prototype Values

£ Properties for template

type filter text

I» Resource
Builders
> CfC++ Build
[ C/C++ General
Linux Tools Path
a MCU
ARM Toolchains Paths
[l Build Tools Path
| Jumper Path
| OpenOCD Path
pyOCD Path
QEMU Path
SEGGER J-Link Path
Project Natures
Project References
Run/Debug Settings
|| Task Repository
Task Tags
I Validation
WikiText

OpenOCD Path 2T T

Configure the location where GNU MCU Eclipse OpenOCD is installed. The
values are stored in the workspace (not in the project). They are used for
all build configurations of this project, and override the workspace or
global paths.

After installing OpenOCD updates, restart Eclipse for the defaults to be
re-evaluated and use the Restore Defaults button to configure the new

location.
Executable:
Folder: D:\OpenDCD\binl Browse... xPack...

®
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4 Debug

This chapter contains JLink debug and ATLink debug of AT32 series chips.

4.1 JLink debug

The following configurations are needed for JLink debug.

® JLink configuration
® GDB configuration
® SVD peripheral register configuration
4.1.1 Debug configuration
1. Goto “Run” - “Debug Configurations” > “GDB SEGGER J-Link Debugging”> “New

Configuration”. Create a new Debug configuration, configure JlinkGDBServerCL, and fill in
device name, such as AT32F437ZMT7, AT32F413RCT7 or AT32F415RCT7.

Create, manage, and run configurations

= 1,

[ . R | -l 5T Name: template Debug (1)
type filter text El Main (35 Debugger . B Startup | i Source| [ Common| 7, SVD Path
7 €/C++ Application J-Link GDB Server Setup -
I C/C++ Attach to Application Start the J-Link GDB server locally [] Connect to running target
7] C/C++ Container Launcher
9 C/C++ Postmortem Debugger Executable path:  ${jlink_path}/${link_gdbserver}
] ¢/C++ Remote Application Actual executable: C:/Program Files (x86)/SEGGER/ILink_V620c//ILinkGDBServerCL.exe

i C/C++ Unit

. (to change it use the global or workspace preferences pages or the project properties page)
] GDB Hardware Debugging

m

ﬂ GDB Jumper Debugging Device name: AT32F43TZIMTT Supported device names
7] GDB OpenOCD Debugging Endianness: @ Little “) Big
[E] template Debug Connection: @ USB 1P (USE serial or IP namefaddress)
Jcoe pyocp DEbuggl'”g Interface: @ SWD %) ITAG
7] GDB QEMU Debugging
Initial speed: ") Auto _) Adaptive @ Fixed 1000 kHz

7] GDB SEGGER J-Link Debugging
[©] template Debug (1) GDB port: 2331
£ Launch Group

SWO port: 2332 [¥] Verify downloads Initialize registers on start
» Launch Group (Deprecated)
Telnet port: 2333 Local host only [ Silent
Other options: -singlerun -strict -timeout 0 -nogui
P TTRS T SR I- - - W 2 Y TRt VO R S W= TY7= i

2. To set up GDB, select arm-none-eabi-gdb.exe under GCC directory.

3. Select SVD Path for debug register description. You can use the svd file in keil. When AT32 keil
Packet is installed, the svd file can be automatically copied to keil directory.

'

B @ EX] B P~ | Name: template Debug @)

type filter text [ Main [ %5 Debugger [ I Startup [/ Source [C1 Commeon [, SVD Path

] €/C++ Application SVD file (used by the peripheral registers viewer)

T C/C++ Attach to Application
% c: Con PP File path: Keil vS\ARM\Pack\ArteryTek\AT32F435_437_DFP\2.0.4\SVD\AT32FA3750x v2.5vd Variables.
i on

] C4C++ Postmortem Debugger
1] C/C++ Remote Application
i C/C++ Unit

7] GDB Hardware Debugging

] GDB Jumper Debugging

] GDB OpenOCD Debugging
[£] template Debug

] GDB PyOCD Debugging

] GDB QEMU Debugging

7] GDB SEGGER J-Link Debugging
[£] template Debug (1)

8 Launch Group

» Launch Group (Deprecated)

2021.12.13 18 Ver 2.0.0
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4. Debug configuration is done, then go to “Apply”>"Debug”.

ip—— o- WO e PN B0 sE

4.2  ATLink debug

This section demonstrates how to debug AT32 using OpenOCD + Eclipse + ATLink. For details on
ATLInk, please refer to AT-Link_User_Manual_SC.pdf.

This section contains the following contents:

® Eclipse Openocd configuration

® GDB configuration

® SVD peripheral register configuration

Unzip the OpenOCD package file <<OpenOCD_V2.x.x.zip>>.

It includes five directories. The bin file is executable, and the scripts is for configuration files.

OpenOCD includes the following directories.

. bin

. contrib

| OpenULINK
| scripts

| share

2021.12.13 19 Ver 2.0.0
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4.2.1 Debug configuration

2021.12.13

1. To configure OpenOCD path, go to Project->Properties>MCU->OpenOCD Path.

= Properties for template L2 [ —
| Open0CD Path D
> Resource

Configure the location where GNU MCU Eclipse OpenOCD is installed.

Builders The values are stored in the workspace (not in the project). They are
» C/C++ Build used for all build configurations of this project, and override the
> C/C++ General warkspace or global paths.
Linux Tools Path
4 MCU After installing OpenOCD updates, restart Eclipse for the defaults to be

re-evaluated and use the Restore Defaults button to configure the new

ARM Toolchains Paths | .
ocation.

Build Tools Path
Jumper Path
OpenOCD Path Folder: D:A\OpenOCD xPack...
pyQCD Path
QEMU Path
SEGGER J-Link Path

Project Natures

Executable: bin\openocd.exe

Project References
Run/Debug Settings
» Task Repository

Task Tags
> Validation
WikiText
. - . IRestore Qe{aultsl I Apply ]
':?:' [Apply and Close] ’ Cancel ]

2. To configure Debug, go to “Run” = ” Debug Configurations” >”GDB OpenOCD

Debugging”>“New Configuration”.
The configuration items are as follows:

Openocd executable path: D:\OpenOCD\bin\openocd.exe.

Config options: -s ${openocd_path}\scripts -f ./interface/atlink.cfg -f ./target/at32f437xM.cfg.

The “atlink.cfg” refers to ATLink debug tool, and the “at32f437xM.cfg” means that AT32F437
has a 4032 KB FLASH (for other AT32F437 Flash sizes, use at32f437xx.cfg). For other series

such as AT32F403A and AT32F415, the “target/xxx.cfg” should be modified accordingly.

20
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& Debug Configurations - l =

Create, ge, and run confi

OE e B x' B3~ MName: template Debug

|t_',rpe filter text | Main | %% Debugger . Slarlup] Ep Source] = Qommon] 2 svD Path]
[€] C/C++ Application OpenOCD Setup i

[E] CfC++ Attach to Applicati

[€] CfC++ Container Launche

[5] €/C++ Postmortem Debu Executable path:  ${openocd_pathP\${openocd_executable} Browse...| | Variables...

[E] C/C++ Remote Applicatio ||| Actual executable: D:\OpenOCD\bin\openocd.exe

Cii C/C++ Unit

[£] GDB Hardware Debuggin

[£] GDB Jumper Debugging
4[] GDB OpenOCD Debuggin ||| Telnet port: LET

[] template Debug

Start OpenOCD locally

(to change it use the global or workspace preferences pages or the project properties page)
GDBE port: 3333

m

. Tcl port: 6666
[€] GDB PyOCD Debugging )
[t] GDB QEMU Debugging Config options: -5 ${openocd_pathf\scripts -f /interface/atlink.cfg -f ./target/at32f437xM.cfg - [
[£] GDB SEGGER J-Link Debu
A Launch Group -
B Launch Group (Deprecate Allocate console for OpenOCD Allocate conscole for the telnet connection

GDB Client Setup
Start GDB session

Executable name: ${cross_prefixjgdb${cross_suffix} Browse... | | Variables...
G

<« | T

O e —
l

Revert Appl
Filter matched 15 of 15 items Ve ] ’ PEY ]

® | Debug | ’ Close ]

3. Configure SVD files

Download corresponding SVD files for Debug.

@i

O & @ B x| = MName: template Debug

H | Main ﬁﬁ Debugger (ﬁ Startup IGE:/ Source (E Commaon r%_ SVD Path
C/C++ Application
C/C++ Attach to Application

SVD file (used by the peripheral registers viewer)

. Fil th: C:A\Keil_v5\ARNM\Pack\ArteryTel\AT32F435_437_DFP\2.0.4\SVDNATI2F437. B
C/C++ Container Launcher e pa \KeilvS\ARM\PackiArteryTek\A 437 _DFP \ WA o M

C/C++ Postmortem Debugger
C/C++ Remote Application
C/C++ Unit

GDB Hardware Debugging
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e fdt Souce Refodor Nawgate Search Project Bun Windom Help
A [#][m] tome T template Debug. v (= 2 | 8iximum 1 V- + - Cora . Quick Access | 18 | TR [EE)
¥ Debug #ven 2 mainc = 7, perip. ]
4] template Debug (608 OpenoCD Debuggog] < vold EXINTO_TagHandler (votd) - e
i temploeit RS Peripheral Address  Desciption .
44 Thvead #1 (Suspended : Braakpoint) 103 } >, OMAL OMA controter
S maind ot mainc112 0x80003ea & o S
1 2, ove Digital video parate i
- oM EDMA controter t
5, eRTC Resl-time dock
o int. moin(void) 7, ETHERNETDMA Ethernet OMA controer
2, ETHERNET MAC Ethernet media access cc
o SRR, 5, ETHERNET MMC Ethernet MAC managem
i ETHERNET TP Ethernet Preciion time ¢
2132 board_tnit(); BNT BANT
S AN % RASH lash mamory controler
¥ %, GPioa General purpase /03
for(i = 0 1 < BUPPER_LEN; £ +4) % % croe
« :
X 1 = batter(d)s gnoc
) 69100
Gor0x General purpase U0s
(3 =0 = coce petcarraon EREI
2132 1ed _toggle(te02); 0 4
while(t) 1
o132 led_togsle(te02);
delay_ms(g_speed * DELAY);
i
D Consele 1l Ragisters (5] Sroblems () Executables @ Dobugger Console () Mamory &
Mritors & New Rendevings.
o GoA Vae -
DR i
| 0x00000280
| 000000280
| 0x00000280
| 0:00000280
0x00000280
| 000000280
|
| 000000280
| vanaacien
| 000000280
| w0428 000000280
L 1 1 ' . . 1§ ______F __J} ] S O S S—
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4. After completing Debug configuration, go to “Apply”’->"Debug” to start debugging.
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